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Getting Started

Thank you for purchasing DynaComm Connectivity Setiese for
Windowse CE (DCS/CE) version 3.0. The first product of its kind
powerful enough to offer multiple host connectivity on handheld
devices and Windows-based Terminals (WBTs), DCS/CE combines
the power of the enterprise with the flexibility of mobile
computing. Adapted for Windows CE from DynaComm Connectivity
Series 7.0 for Windows 95/NT—FutureSoft’s PC- and Web-to-host
connectivity solution—DCS/CE provides remote access to most
major host systems including IBM, Tandem, Hewlett-Packard,
Digital, and UNIX.

DCS/CE brings portable computing into the mainstream of enterprise
computing by allowing access to host-based applications. No longer
just a device for email or maintaining a calendar, devices powered

by Microsoft Windows CE become true computing appliances with

DCS/CE, extending the reach and accessibility of enterprise
applications. Businesses now have a new way to deploy mission-
critical applications as they seek new competitive advantages,
providing seamless connectivity to anyone traveling or working

from remote locations.

With a wide variety of terminal emulations, DCS/CE emulates a
terminal on most large remote systems. DCS/CE contains the
following emulations: ADDS VP/60; ANSI-BBS; AT&T 605/705;
TeleVideo 925/950; Digital VT-52, 100/102, 220, 320, and 420; and
Wyse 50/60. FutureSoft offers other emulations that you can
purchase separately as a DynaComm Client Optione for the
following terminals: AT&T 4425,1BM 3270, IBM 5250, Tandem
6530, and HP 700/94.




Package Contents

The package for DCS/CE contains the following items:
Product Registration card.

Floppy disks (3.5 in.) containing DCS/CE, any DynaComm Client
Options you may have purchased, and online Help
documentation for all DCS/CE products.

Documentation

This Getting Started document as a PDF (Portable Document
Format) file called GtStrt.PDE. The file is located in the DCS/CE
installation directory on your desktop computer, and on the

documentation diskette.

An online help file (DynaCE.HLP) located in the DCS/CE
installation directory on your desktop computer, and on the

documentation diskette.

Note: The Help files are for use on a Windows 95/98/NT system only.

System Requirements

Windows CE Services 2.0, or higher, installed on your desktop PC.

A device powered by Microsoft Windows CE 2.11, or higher, utilizing a
MIPS, SH3, SH4, or StrongARM processor. FutureSoft will support
additional processors as the market demands. If your device has a
processor other than those listed, contact FutureSoft for more

information.

Installing or Removing DCS/CE

Overview

Installing DCS/CE or a DynaComm Client Option is a two-step process.
First, you must copy the installation image of the DCS/CE files onto
your desktop computet, using the DCS/CE Installer. Besides copying
installation files to your desktop computer, the Installer also registers
DCS/CE with the Application Manager (CEAppMgr. EXE), which is a
part of Windows CE Services on your desktop computer. Second, the
Application Manager must install DCS/CE from the desktop computer to
the device powered by Microsoft Windows CE.

Note: You must install the core DCS/CE Core Product before installing

any of the DynaComm Client Options.

When removing DCS/CE, you have three basic options. The

removal option you choose depends on the storage needs of your

desktop computer and the device and how you use DCS/CE. The
first removal option uses the Application Manager to remove DCS/CE
from the device, while keeping DCS/CE registered in the Application
Manager. This choice allows you to remove DCS/CE from the device
when you temporarily need the storage space for another program.
When you want to reinstall DCS/CE on the device, the Application
Manager allows you to do so without setting up the files on your

desktop computer again.

The second removal option uses the Application Manager to remove
DCS/CE from the device and to delete the DCS/CE registration
from the Application Manager. This choice allows you to reclaim
space on the device and requires you to completely reinstall
DCS/CE on the desktop computer and the device before you can
run DCS/CE again. This choice is useful when you upgrade DCS/CE.

The final removal option removes the installation image of DCS/CE
from the desktop computer. This choice allows you to free disk
storage space on your desktop computer, while keeping DCS/CE
registered with the Application Manager.

Installing

Installing DCS/CE requires you to have installed Windows CE Services
(version 2.0, or higher) on your desktop computer. The DCS/CE Installer
does not require that your device be turned on and connected to
the desktop computer; however, if the device is on and connected,
the Installer will automatically start the Application Manager after
the Installer has copied and registered the installation image on
your desktop computer. The Application Manager will then install
DCS/CE on your device, installing it in one step.

Note: Only install DCS/CE or any of the DynaComm Client Options
in the defanlt application install directory.

Installing the Installation Image on the Desktop Computer
1 Insert Installation Disk 1 into the floppy dtive of the desktop PC, or
open the folder into which you have downloaded DCS/CE.

2 Open the folder Disk 1.

3 Double-click Setup.EXE to start the installation. The Installer will
guide you through each step of the process, asking you to accept
the license for DCS/CE (or one of the DynaComm Client
Options), provide information for your copy of DCS/CE, specify
a location for the installation image of DCS/CE, name the DCS/CE
program shortcut (which will appear in the Windows Start menu

on the desktop computer), and view the Readme.

During the installation, the Installer gives you a choice between a
Typical or a Compact installation. The Typical installation
contains all of the components of DCS/CE, and the Compact
installation contains only the basic DCS/CE components and is
for devices with constraints on the available memory. The
Compactinstallation contains the following components: the
Telnet connector, the ANSI-BBS and Digital VT emulations, and



the Kermit and ZModem file transfer protocols. The Compact
installation does not contain the Modem and Direct Serial
connectors, XYModem file transfet, and the following terminal

emulations: ADDS VP/60, AT&T 605/705, TeleVideo 925/950,
and Wyse 50/60.

4 Click Finish in the last dialog of the installation. If the device is
connected to the desktop computer, the Application Manager will
automatically start installing DCS/CE on the device. However, if
the device is not connected to the desktop computer, the
Application Manager will start and indicate that it will install DCS/CE

the next time the device and the desktop computer are connected.

Installing DCS/CE on the Device after Installing and
Registering the Installation Image

After you click Finish in the last dialog of the DCS/CE installation, or
after you have connected the device and desktop computer, the
Application Manager will start automatically on your desktop
computet, asking you whether DCS/CE should be installed in the
default application directory.

Click Yes to install DCS/CE, or click Cancel to stop the installation
process. If you click Yes, the Application Manager will display a
dialog with a progress bar. When the Application Manager on the
desktop computer indicates that the download is complete, the device
will then show the installation progress. While the installation is
completing on the device, click OK in the Application Downloading
Complete dialog on the desktop computer to close all of the
Application Manager dialogs.

If you click Cancel, you may install DCS/CE or a DynaComm
Client Option at a later time on the device. To install, see the
section, “Installing DCS/CE on the Device After Removing DCS/CE

from the Device,” below.

Installing DCS/CE on the Device after Removing DCS/CE
from the Device

This procedure assumes that you have already installed an installation
image onto the desktop computer, and that you have not deleted
or uninstalled the installation image, and have not deleted the DCS/
CE registration from the Application Manager.

1 Connect the device and desktop computer physically (for instance,
through a serial port, Ethernet network, infrared connection, modem,

or some other connection).
2 Start Windows on each computer.

3 After Windows has booted on each device, open the Mobile

Devices folder in My Computer.

4 Make sure that the device and the computer have established a

partnership connection over the physical connection.

5 Select Application Manager in the Tools menu in the window for
the Mobile Devices foldet.

6 In thelist box of the Application Manager dialog, check
FutureSoft DCSCE (and the names of any DynaComm Client
Options).

7 Click OK in the Application Manager dialog. The Application
Manager will then start downloading DCS/CE to the device, as
described in the section “Installing DCS/CE on the Device after

Installing and Registering the Installation Image,” above.

Removing

Removing DCS/CE from the Device
Using the Application Manager
Perform the same steps as in “Installing DCS/CE on the Device
after Removing DCS/CE from the Device;” however, in step six,

uncheck the items that you want to remove from the device.

Using the Remove Programs Control Panel on the Device
1 Select Start in the Windows Taskbar on the device. Windows

will display the Start menu.
2 In the Start menu, select Settings and then Control Panel.

3 Double-click Remove Programs in the Control Panel folder.
Windows will display the Remove Program Properties dialog.

4 Select FutureSoft DynComm Connectivity Series (or an
installed DynaComm Client Option) in the Remove Program

Properties dialog.

5 Click Remove in the Remove Program Properties dialog.

The control panel displays a confirmation dialog.
6 Click Yes in the Remove Program confirmation dialog.

7 To remove other installed components, repeat steps four

through six.
8 Click OK in the Remove Program Properties dialog.

Removing DCS/CE From the Application Manager
This procedure deletes a registered component (DCS/CE or a
DynaComm Client Option) selected in the Application Manager

and deletes the component from the device.

1 Connect the device and desktop computer physically (for instance,
through a serial port, Ethernet network, infrared connection,modem,

or some other connection).
2 Start Windows on each computer.
3 After Windows is running on each device, open My Computer

on the desktop computer, and then open the Mobile Devices
folder.



4 Make sure that the device and the computer have established a

partnership connection over the physical connection.

5 Select Application Manager in the Tools menu in the window for
the Mobile Devices foldet.

6 In thelist box of the Application Manager dialog, highlight
FutureSoft DCSCE (or the name of a DynaComm Client Option).

7 Click Remove in the Application Manager dialog. The Application

Manager will display a confirmation dialog.
8 Click OK in the Remove Application confirmation dialog.
9 To remove other components, repeat steps six through eight.
10 Click OK in the Application Manager dialog.

Removing the DCS/CE Installation Image from the

Desktop Computer

Note: This Uninstaller removes both the DCS/CE installation image
and any of the installation images for DynaComm Client

Options.

1 Select Start on the Windows Taskbar on the desktop computer.
Windows will display the Start menu.

2 In the Start menu, select Settings and then Control Panel.

3 Double-click Add/Remove Programs in the Control Panel folder
to display the Add/Remove Program Properties dialog.

4 Select the Install/Uninstall tab.
5 Select DCS/CE in the list box.

6 Click Add/Remove to start the DCS/CE uninstaller.

How To Use DCS/CE

On your device, DCS/CE allows you to interact with a remote host

ora BBS. You can quickly configure an emulation, a file transfer

protocol, and a connector, and then connect to a remote system.
And, if you want to connect to the same system again, you can save
the configuration to a file. To connect to the remote system again,
double-click the file, and DCS/CE connects to the system.

To Start DCS/CE

1 Select the Start button in the Windows taskbar to display the

Start menu.

2 Inthe Start menu, select Programs and then DCS. DCS/CE will

startand open a default session window.

Note: To start DCS/CE from the Windows desktop, make a shortcut
for DynaCE.EXE or a session file on the desktop.

To Stop DCS/CE

Select the Close button (X ) in the upper right corner, or select Close
in the File menu. If you have not saved the session configuration to a

file when you exit DCS/CE, it will ask you to save the configuration.
After you have saved the session configuration to a file or deleted

the session configuration, DCS/CE will then close.

To Configure a Session

A session file specifies the configuration of the session window.
Most importantly, a configuration specifies the method of connecting
to the remote system (the connector), how to transfer files (the
file transfer protocol), and the terminal that DCS/CE will emulate
while connected to the remote system (the emulation). Besides
the connector, file transfer protocol, and emulation, you can also con-
figure how the session will look as well as other options. The steps
below are an overview of configuring a new session. For more details,

see DynaCE.HLP on your desktop computer.

1 Start DCS/CE as described above in “To Start DCS/CE.” An empty

session window will open with the default configuration.

2 Select Properties in the Session menu. DCS/CE displays the
Session Properties dialog with the Connectors tab highlighted.

3 Select the name of a connector: Telnet, Modem, or Direct Serial.

Note: If you selected the Compact Installation, Telnet is the

only available connector.

4 Click Properties to configure the properties of the connector
that you selected. Minimally, the Telnet connector needs the
address or name of the host, and the Modem connector needs
the telephone number of the system. Depending on the con-
nection and type of session, you may need to make further
changes to the properties of the connector. For changes to the
Telnet connectot, select the Terminal or Other tabs. For changes
to the Modem connector, click the Modem Properties button

and the Dialing Properties button in the TAPI Properties dialog.

5 After configuring the connector, click the Close button (X ) in

the connector’s dialog.
6 Select Emulations in the Session Properties dialog.

7 Select the name of an emulation in the list box.



8 Click the Properties button to display the Emulations dialog and to
configure the emulation. Besides configuting the emulation’s
parameters, the Keyboard tab in the dialog also allows you to

change the function of the keyboard and to create toolbar buttons.

9 After configuring the emulation, click the Close button (X ) in

the emulation’s dialog.
10 Select File Transfers in the Session Properties dialog.

11 Select the name of a file transfer protocol. You should select a

protocol that also exists on the remote system.

12 Click the Properties button if you must configure the protocol.
For most connections, configuring the file transfer protocol is

unnecessary.

13 After configuring the file transfer protocol, click the Close
button (X ) in the protocol’s dialog.

14 Select Display in the Session Properties dialog.

15 Click the Properties button to display the Text Display Properties
dialog. This dialog allows you to change the appearance of the
session window and to determine the size of the session window’s

history buffer.
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After configuring the session display, click the Close button (X )
in the Text Display Properties dialog.

17 Select Options in the Session menu to display the General Options
dialog. The configuration in this dialog determines whether DCS/CE
will automatically attempt to connect a session when you open

a session file and determines the function of your stylus.

18 After configuring the general options, click the Close button (X )
in the General Options dialog.

The session is now ready to connect to the remote system. See “To

Connect to or Disconnect from a Host” below.

If you want to save the configuration of this session, select Save or

Save As in the File menu.

Tip:  To start DCS/CE with a saved session configuration, make a
shortcut for the session on the Windows desktop.

To Connect to or Disconnect from a Host

To connect a session to a host, select Connect in the Session menu.
DCS/CE will then attempt to connect to the remote system selected
in the Session Properties dialog. After DCS/CE connects the session,
Connect will become Disconnect in the Session menu. You can now

log into and interact with the remote system.

To disconnect from a host, log out of the remote system and then

select Disconnect in the Session menu.

To Use aTerminal Function

Each terminal emulation maps the functions of the terminal’s
keyboard to a key on the PC keyboard. Some of the terminal keys
and functions are naturally the same on the PC keyboard, such as
the alphanumeric keys, Shift key, and Enter key. Howevet, some
terminal functions must be accessed via key combinations or the

PC’s function keys.

The nature of the keyboard of most devices powered by
Windows CE precludes the use of function keys and some key
combinations, that a terminal emulation on a desktop computer
might allow. For terminal functions without a natural equivalent
on the device, select the Keys menu, hold down any modifier keys
(the Alt, Ctrl, and Shift keys) that may be required, and then select
the name of the terminal key or function in the menu. The content
of the Keys menu depends on the terminal emulation that you

selected in the Emulations dialog (Session > Emulation).

Besides the Keys menu, the Properties dialog of each emulation has
a Keyboard tab, which allows you to use the DCS/CE Keyboard Map
Editor to redefine the function of the keyboard and to create toolbar
buttons for the session. The Keyboard Map Editor can configure
keys or toolbat buttons to perform a terminal function or to send a
sequence of characters or an escape sequence. For more
information, see the “Keyboard for a Session” topic in the online
help (DynaCE.HLP) on the desktop computer.

To Save the Current Session Configuration

After configuring or changing a session window with options in
the Session menu (as in “To Configure a Session”), select Save or

Save As to save the configuration to a session file.

Information in this document is subject to change without notice and does not represent a commitment on the part of FutureSoft. The software described in this document is furnished under a
license agreement. The software may be used or copied only in accordance with the terms of the agreement. No part of this document may be reproduced or transmitted in any form or by any means,
electronic or mechanical, including photocopying and recording, for any purpose other than the purchaser’s personal use without the written permission of FutureSoft.
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Visual Quick Reference

Menu Bar

File Edit' Session

Keys |

Application Toolbar —‘

Close
User Toolbar —‘ Help —‘ —‘
l X

\— Session Window Border
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Session Window Border J

Session Screen Scroll Bar

Open.
Opens a saved session configuration.
Save or Save As.

Preserves the configuration
of the session to a file.

Copy.

Copies selected session char-
acters to the Windows clipboard.
Paste.

Inserts characters at the
session cursor.

Session Properties (Alt + Enter).
Displays the Session Properties dialog.
Connect/Disconnect. ———

Connects a session to a host, and
disconnects a connected session.

=

| o]

J \— User Defined buttons.

Create up to 27 buttons
in a keyboard map for
an emulation.

Toolbar Slider.

Drag to expand or contract
or double-click to maximize
or restore the width of the
user toolbar.

Open...
Save
Save As...

Futuresoft Print Setup
Print

Close

About...

Open Closes the current session, allows you to
select a previously saved session configuration,
and opens the file.

Save Preserves the configuration of the session
window to a file with a SES file type. You must name
previously unsaved configurations.

Save As Saves a previously saved session
configuration under another name.

Futuresoft Print Setup  Displays the optional
Network Printing dialog. You may configure
DCS/CE for printing to a network printer.

Print Prints the contents of the session window to
the specified printer.

Close Closes an ongoing session and then quits
DCS/CE.

About Displays version information about DCS/CE.

Copy
Paste
Select All
Send

Clear Screen
Copy Screen to Buffer

Copy Copies characters currently selected in the
session window to the Windows clipboard.

Paste Inserts characters, previously copied to the
Windows clipboard, at the current location of the
session cursor.

Select All Highlights the entire contents of the
active session (not its history buffer).

Send Transfers the selected text in a connected
session to the remote system.

Clear Screen Deletes all characters in the active
session screen.

Copy Screen to Buffer Copies the active session
screen to the session window's history buffer
(defined in the Text Display Properties dialog).

Session

Connect
Properties...

Send File...
Receive File...

Reset L4
Macro (3
Break

Connect/Disconnect Connects an unconnected session to a
host, and disconnects a connected session.

Properties Displays the Session Properties dialog, where
you configure a connector; a terminal emulation, including
keyboard configuration and toolbar creation; a file transfer
protocol; and text display properties in the session.

Send File Displays the Send dialog, where you select a file
to send to a host after the system is prepared to receive the
file.

Receive File Displays the Receive dialog, where you select a
path name for a file, that a host will send to DCS/CE.

Reset Displays a sub-menu of options for changing the
operation of the emulation (see below).

Macro Displays a sub-menu for starting or stopping a macro.
Break Sends a break signal to the remote system, typically

terminating the current process. The actual response is host-
dependent.

Hard Reset
Soft Reset
Reset to Defaults

Hard Reset Similar to turning a terminal off then on.

Soft Reset Similar to activating a terminal’s reset
function.

Reset to Defaults Resets the emulation to its default
settings.

PF1 correspol

Keys Menu The contents of the Keys menu are options

nding to terminal and keyboard functions of the emulation

chosen in the Session Properties dialog. The contents of the menu

PF2 changes

, depending on the selected terminal emulation.

How to Contact FutureSoft

For further information, please contact FutureSoft at:
FutureSoft, Inc.

12012 Wickchester Lane

Suite 600 Houston, Texas 77079-1222

Voice: 281.496.9400 Fax: 281.496.1090 Email: info@futuresoft.com Web: www.futuresoft.com

For technical support, please contact FutureSoft at:
Email: support@futuresoft.com Voice: 281.588.6868




